UBUILD r A BOOK

Thank you for choosing U Build A Book. We hope this Photo Book Software-
User Guide is helpful in introducing you to our free software. See our Photo
Book Software-FAQ for additional assistance, or call us at 866.909.3003. We
are available for support M-F 8am-5pm PST.

Follow these easy steps to create your book:

STEP 1 Loading Your Images

STEP 2 Locating Your Book Pictures
STEP 3 Adding Images to Your Pages
STEP 4 Adjusting Images on Your Pages
STEP 5 Two-Page Spread

STEP 6 Single-Page Spread

STEP 7 Creating Page Layouts

STEP 8 Captions

STEP 9 Page Backgrounds

STEP 10 Align Images

STEP 11 Distribute Images

STEP 12 Cover

STEP 13 Sending Your File to U Build A Book
STEP 14 Order Form




Our free design software will enable you to create professionally designed, richly customized photo books. Including:
free stylere-sizing and placing of content, collages of images, faded backgrounds, text (in any language, any font and any
place), frames, pre- designed backgrounds, and much more.

To Build A Book, Simply:

1. Download the UBuildABook Photo Book Software software from our web site: www.ubuildabook.com
2. Select your book size and cover type

3. Build your book with templates, images and text

4. Submit your order for printing

PC Users:

1. Click the link to Download the PC Version

2. Double-click the file called MyPhotoBooksl nstaller.exe (For Windows Vista users, please right-click on the software
icon and choose to “Run as Administrator” under properties.)

3. After installation, the design software and user guide will be added to your “Programs’” menu.

4. Double-click the desktop icon to launch and start building your book

Mac users:

1. In Safari, go to the Safari menu and choose preferences

2. Under the General tab, un-check the section that says "Open ‘safe’ files after downloading”

3. Download the Mac software - this should put a zip archive where you're downloading to

4. Double click to unpack the zip file, providing you with an application. If this does not work, try Control+Clicking on
the package and choosing BOM A rchiveUTtility.

Once the software has been installed and you open
the program, you will be given the options shown
to theleft. You can open a saved book, or create a
600 Welcome new one. Use the fast track option to use pre-
selected book layouts and designs.

Create New Book Fast Track Open Saved Book
Next, you will pick the size of the book you wish
e e to _create. Please choqse wisely, as you cannot
' switch between Portrait and Landscape once you
' Select a book type to start. You may add or remove pages later. begin desi gni ng you_r book. This Sample Wi”_ be
. | Landscape 6x9 Hard Cover ) created on the Portrait, 8.5x11 Hard Cover option.

v Landscape 6x9 Hard Cover
Landscape 6x9 Soft Cover
Landscape 8.5x11 Hard Cover
Landscape 8.5x11 Soft Cover
— Portrait 6x9 Hard Cover
Portraat 6x9 Soft Cover
Portrait 8 5x11 Soft Cover I




Now you are ready for the fun part! First, there are a few
buttons and options you should become familiar with:

Use these tools to move
through the pagination.

L$\\Fw Help

zoom out
zoom in
view full page
;2| view actual size
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selection tool
image frame tool

text tool
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rotate clockwise
rotate counter-clockwise
undo rotate

remove image filter

black and white image filter

sepia image filter
fade image (opacity)

“Perfectly Clear Image”

enlarge image in frame
reduce image in frame
fit image to frame

font type
font size
bold or italic font

paragraph alignment
font color

Load images for your book here

®

s .| Page Backgrounds Il Picture Borders i Book

add images
add image folder

|:| hide images that have been used
clear images in browser
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Remember to “Save” your progress as you go. Also, do
not be afraid to play around with the software and get
comfortable with using it. There is always the option to
“Undo” found under the “Edit” drop-down menu.




la. Load Images
The first step will be loading the images you will be using for your book. Select the “add images” button on the lower left, shown
below.
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Load images for your book here

1b. Load Images
Once you have found the folder with your images, you may “select all””, shown on the upper left, or manually check the images
you wish to use by clicking on the check boxes found at the upper right corner of each image.
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2. Locating your Book Pictures

Your book begins here
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3. Adding Images to your Pages

After choosing the images you wish to use for your book, they will display in the “Book Pictures” browser at the bottom
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Next we will add an image to the page. Select your “Page 1” at the top. (We will return to the cover later.) You will need to create
an “image frame” using the tools we showed earlier. Select the tool, and begin to “drag” out a frame on your workspace
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3b. Adding images to your page

image into the frame.
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4a. Adjusting Images on Your Pages.

Once you have placed the image into the frame, you will have the option of re-sizing, moving, and rotating the image. You may

click and drag the image to move it around the workspace. A grid will appear when moving the image to show you where the crop
margin is for each page and to help with alignment.
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4b. Adjusting Images on Your Pages
To make the frame bigger, click and drag the corners or sides out. Remember to be aware of the crop and bleed margins. Keep

your image inside the red line to ensure it is not cropped or extend your images to the edge of the workspace (out of the red line)

to have “full bleed” images/pages.
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4c. Adjusting Images on Your Pages
If you wish to have the grid and margins displayed at all times, select the “Show Grid” option from the “View” drop-down menu.
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5a. Two-Page Spread
Next we will create a two-page spread. Select “Page 2” from the top. If you do not see the pages in “spread” format, select
“Facing Pages” from the “View” drop-down menu. Next, select and image from the browser below. Do not create a frame. Drag

and drop the selected image or v0-Page Spread” when prompted.

] @ My Photo Books File Edit Insert Format | MR Help @ Thu 11:06 AM
Peae « Facing Pages oks - New Book (Untitied) - Portrait 8.5x11 Hard Cover
:“_ : = | ® SanaTo UBuddABook | | 4 Fast Track
Setup Grid [
Show Grid
| Snap to Crid | | | [ |
Ifrom'| l2 | il 12 /{13 I8l 14 )l 15 16l 17 1l 19 1 20 Back
- % A a4 A
Single page
Layout picture
Add picture
{ Cancel
"ql 0] il Page Layouts || Page eimgrounusmsmmmrricare Borders \:‘;usook‘rmphm
in bl o

5b. Two-Page Spread
Your image will be displayed across two pages. Please note: if the image is not large enough originally, it will be stretched to fit

the two pages. Be cautious as this often results in a decrease in the resolution. This will be displayed at the bottom.
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5¢. Two-Page Spread
To remove the two-page spread, simply right click (or ctrl. mouse-click on a Mac). Select “Edit”-"Remove Page Background.”
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6a. Single-Page Spread
Next we will learn a single-page spread. Select the image you wish to use, and drag and drop it onto the page. Do not create a
frame. Select “Single-Page” when prompted.
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6b. Single-Page Spread
Your image will display, covering the page. Again, be cautious of stretching images as it lowers the resolution.
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7. Creating Page Layout with Multiple Images ]

To add many images to the page, you may add image frames to the page manually, or choose from pre-created “Page Layouts”
at the bottom. The layouts are organized by the number of frames on each page. The layouts on the left begin with one or two
frames, and increase as you scroll to the right. You may always add or subtract frames from the layout you choose.
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7b. Creating Page Layout with Multiple Images
Drag and drop the selected layout onto your page.
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8. Captions

Select an image for each frame. Drag and drop each image into the proper frame. Next you can add captions. Select the “Type-
Tool” at the upper left, and click and drag a text box where desired.
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8b. Captions

Once you have created the text box, double click on the box to select it. Highlight the default text and type your caption. Simply
click outside of the text-box to exit the type mode.
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8c. Captions

You may then re-size the text, and change the font. Be sure your text box is selected (using the arrow selection tool). Select the
drop-down menu displaying the fonts. Or the “font size” drop-down menu to increase or decrease font size.
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9a. Page Backgrounds

There are also pre-designed “Page Backgrounds” available to include in your book. These are used similar to the single, or two-
page spreads. Drag and drop the selected background onto the workspace. Select single or two-page spread. You may also use
your own images for page backgrounds.
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9b. Page Backgrounds ) ) ) ) )
Using the page background, you can layer your designs by adding page layouts, images and captions to create more dynamic

designs. Select the “Picture Borders” to add frames to your images. Select the frame you like and drop it onto the appropriate

image.
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10a. Align Images

Once you have added frames, images and borders to your images, you may move them around and/or align them. Using the “Selec-
tion Tool”, click on one image, hold down the “Shift” key on your keyboard, and click on another image. (If you are using a Mac,
you may need to hold the apple key + control to select multiple images.) Next, right click over the images, select “Alignment”-and
choose the desired option.
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10b. Align Images
Below is the result, using “Align Top”.
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11a. Distribute Images

Another feature to be aware of is the “Distribute Images” option. First, add frames to the pages you select. Choose
“Layout”,”Distribute Pictures”. You will be asked to “replace” or “preserve” the images already in your book. To keep the work

you have already done, select “preserve”. If you wish for the images already in frames to be replaced, select “replace”
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The program will distribute random images into the frames you created. All the images that have been used from the browser

below will be labeled with a yellow “*” to ensure none of the images were used twice.
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12a. Cover
Designing your cover is as simple as the pages. Choose the “Front” or “Back” cover, and select and image or page background
to use. Drag the image you choose onto the front cover, without creating an image frame first. You will then see the options

shown below.
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12b. Cover
The example below was created using the “layout picture” option, and then enlarging the frame and image. Note that extending

the image past the red margin, to the edge, will allow for full bleed on the cover. You can also add text to your cover.
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13a. Sending Your File To U Build A Book

The final step will be to “Send to UBuildABook”. Click on the option at the upper left. A pre-print report will display showing
any problems found with your book. Review these warnings before proceeding.
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3 Select "Proceed With Printing” to continue or "Cancel Printing” to go back and make changes to
your book.
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13b. Sending Your File To U Build A Book
Once you have selected “proceed” your job will begin processing and sending to UBuildABook. Be patient as this can be a
timely process if your images are large, or computer speed is slower than average. Once it has finished “precessing” you will
be asked to view the pages and cover and approve it. This is your last opportunity to make revisions before sending.
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Uplgad Dialog

Your order is now ready to be sent to print. Upload time may vary based on the
Internet connection type, network load and file size.

Progress...

Preparing your print job

1 Page Layouts
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your job, please review your job at this point.

{ Cancel ) ( Continue )

Printer drivers, fonts and other settings on your system may, in Some cases, cause
the printed output to look different in print than on screen. To ensure the quality of

To review your job before it is sent to print, click "View”,

| have examined the proof for correctness of text, fonts, missing images and
& image quality. | understand that this proof represents the final printed item.
| approve the printing to be done based on this file.
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13c. Sending Your File to U Build A Book
Once your book has uploaded successfully, you will be given a reference number for your order.
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successful
Your order was created and uploaded fully. Ref: PhotoBook_14 72252.

A web browser will now open to let you complete the order. This may
take up to 30 seconds.

Click Okay to open a web browser and complete the order.
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14. Order Form
The final step will be completing an order form. You have now successfully completed your first book using our Photobook

Software. We hope you enjoyed using it, and we welcome your feedback. Thank you for doing business with us.
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You Design The Content, You Design the Cover, We build the Book. 1
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